
Emma Harris // Operations Director

Welcome

In this issue//

Quite a meaty Connector to start the year off (with a few 
fun photos near the end to provide some light relief ). This 
edition picks up on many of the themes covered in the 
business and technical tracks of Triaster’s Conference last 
year, with articles focusing on: supporting your Business 
Process Management (BPM) journey; part one of a four part 
series on quantifying the benefit of Process Improvement 
and a glimpse at future Triaster software development 
planned. There is also, as promised by Michael Cousins 
during the conference close, a 3 ‘U’s checklist.

With the new year we are also starting on a new programme 
of events. One not to be missed if you are in the public 
sector is ‘Enabling Change in the Public Sector’, which is 
taking place on 5th February at the Microsoft offices in 
London. Speakers from Northamptonshire Police, Multi-
Force Shared Services (MFSS) and NHS Gloucestershire will 
share their experiences of working with Triaster to achieve 
cultural transformation, process improvement and achieve 
their targeted budget savings.

The Functionality CatchUp event on 25th February, is also 
a must for anyone who missed last year’s conference and 
who is particularly interested in the latest developments in 
Triaster’s Simulation capabilities to quantify the benefit of 
Process Improvement.

We also meet Joel Evans, are reminded about User Group 
events and are treated to a suitably technical Tech News and 
some process mapping tips.

I hope this gives you a great start to 2015.

emma.harris@triaster.co.uk         +44 (0)870 402 1234

Supporting your Business
Process Management Journey
Triaster are with you every step
of the way.

Business Analysis
Quantifying the benefit of Process
Improvement– part one.

T.U.G. (Triaster User Group) News
Looking forward to 2015.

Enabling Change in the
Public Sector
A major event on 5th February.

Triaster Software Development
A Glimpse of the Future.

Tech News
Using Notepad++ to edit and check XML files.
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Keeping you up-to-date.
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3 ‘U’s checklist
As promised at the Conference.
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When we start working with any organisation – even before they become a customer - we always spend 
time to identify the business objective for their Process Library. The one that the Process Library needs to 
deliver on. We then work hard to ensure that objective is achieved - as our customers can testify. However 
(and it will be of no surprise to most of you) there is often more than one objective and these objectives 
usually change over time. 

Supporting your Business Process
Management Journey
Triaster are with you every step of the way

SIMULATE AND 
QUANTIFY BENEFIT

OF PROCESS 
IMPROVEMENT

OPTIONS

STAKEHOLDER
SUPPORT

FOR PROCESS 
IMPROVEMENT 

BUSINESS PROCESS MANAGEMENT JOURNEY

IMPLEMENT
CHOSEN PROCESS 
IMPROVEMENTS
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Victoria Glancy & Carma Cooper // Client Services Team

Supporting your Business Process
Management Journey

Capturing and sharing processes is only the beginning of a Business Process Management (BPM) journey. 
Below is a pictorial representation of some of the likely phases you will work through during a BPM 
journey. Notice the journey is circular. You will always be redeveloping processes dependent on business 
need and this ensures continuous business improvement.

IDENTIFY
BUSINESS CRITICAL 

PROCESSES /
FUNCTIONS

BUSINESS PROCESS MANAGEMENT JOURNEY

CAPTURE AND
VALIDATE

CURRENT STATE
END-TO-END
PROCESSES

EMBED / 
REINFORCE PROCESS

CULTURE
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To best assist our customers with every step of this journey Triaster is continually evolving the Triaster 
Solution, both its software and services. However we know that sometimes our customers take time to 
try these out in their own organisations. To try to make sure customers are realising all the benefits of the 
Solution, we do aim to keep everyone up to date with the latest functionality as much as possible:

1. Via Triaster Product Release and Technical Updates which you can sign up for by completing a form 
found at: www.triaster.co.uk/contact.php

2. Through the Connector newsletter - which you can sign up for at: www.triaster.co.uk/connector

3. At Triaster events and webinars - a rolling programme of events can be found at:                                
www.triaster.co.uk/events

Added to these, we are pleased to launch a new series of ‘Where are You?’ reviews for all our customers, to 
help you assess where you are on your BPM journey. Jo Dolton will be contacting all Triaster customers to 
arrange this in the near future. If you would like more information prior to this, contact her on:
customer.services@triaster.co.uk.

Missed the conference?
 
Functionality update was a key objective of the 2014 Triaster 
Conference. If you missed this, there is a great opportunity 
join us at the free Functionality CatchUp event on 25th 
February from 9.30am to 2.30pm at our offices  in Wallingford. 

We can’t possibly provide a digest of all the conference 
content, notably the contributions from the keynote 
speakers, instead the agenda will focus on these key sessions:

•	 Roundup of the most beneficial Triaster Solution 
functionality: Triaster Releases 2014
Carma Cooper and Victoria Glancy

•	 Simulation and Business Analysis: Quantifying the 
Benefits of Business Improvement
Michael Cousins

•	 Creating Useful, Usable and Used Process Libraries:    
Roses, Buds and Thorns
Paul Elson-Vining and Joel Evans

Refreshments and lunch are provided and as usual there will 
be opportunities to network with other customers. Further 
details and a booking form can be found here:
www.triaster.co.uk/functionalitycatchup

If you cannot attend this event in person, contact
customer.services@triaster.co.uk to arrange to
attend via a webinar.
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Business Analysis
Quantifying the benefit of Process Improvement– part one

Michael Cousins // Managing Director

One of the key benefits of the Triaster Solution is that you can use it to model your organisation, simulate 
changes and measure them to find the most effective.

This is the first in a series of four articles setting out the steps involved in producing a business case 
for process improvement, based on the outcome of a simulation analysis of the as-is process, when 
compared with one or more variants. 

These concepts and ideas were first introduced in the ‘Simulation and Aggregation’ article, published in 
the January/February 2014 issue of the Connector, and which can be found here: 
http://tinyurl.com/tri-01-15-simulation

Process Improvement

The overall process of change is illustrated below:

Some process exists that transforms an Input to an Output. In Version 1 of the process, this transformation 
takes 8 days and costs £14,000.

Through business analysis, an improved process is developed, Version 2, and this costs £3,000 less and 
completes 1 day sooner.

INPUT OUTPUT

Version 1, costs £14,000 and takes 8 days

INPUT OUTPUT
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With Triaster, this improvement happens in four distinct steps:

1. Version one is mapped out and ring-fenced into a specific business analysis library so the analysis, 
which might involve sensitive data, can be performed discreetly.

2. A Triaster Data Manager is created to enable easy updates of the basic performance data.

3. The Triaster simulation engine is used to estimate the value of all relevant quantitative metrics.

4. Version one is cloned into a specific site for Version two and as many other variants as the business 
analyst needs.

Having completed these four steps, each variant is simulated, re-engineered and refined until a better 
process is established and a business case for change can refer explicitly to Version one and Version two, 
and allow managers and stakeholders to drill-down into the detail.

Step one: Create a Business Analysis Library

The first step is to clone your existing process library into a ‘fenced-off area’ where you can carry out 
simulation and analysis without modifying live processes. This is now considered in detail.

So that you can walk through the steps in this article, Triaster have an on-line demonstration library here:
www.triaster.co.uk/example-process-library

However, it will work much better if you are able to clone a library on your own server. If you would like to 
obtain the actual maps that are used in this example, please e-mail me personally
(michael.cousins@triaster.co.uk) and I will supply them for you.

We have two choices, we can either clone the whole library including its Live, Draft and Sandpit sites, or 
we can create a new site within the library. It really doesn’t matter at this stage which we go for, but I shall 
clone the whole library in this article.

To do this, log into the Administration tool, click on Library Explorer at the left of the screen, and then 
select the library you wish to clone (in my case ProcessLibrary).

6

On the right of the screen 
click the option to Clone 

the library.
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I am going to call it ‘Recruitment To-be’ in this article because this is the specific process we will be 
looking at.

After you click Create Library, the product will

1. Copy the process maps from the current Library into a new folder in the Map Store

2. Create the new Library itself

Once you have received the notification that the library has been cloned, the Library Explorer will contain 
the new Library, Recruitment ToBe.

Open the Recruitment ToBe Live site, and perform a publish to ensure you are viewing the most recent 
maps in the Library.

Unless somebody is an Administrator (or happens to know the name of the library you have created), 
there is no way a person can get to your library from the interface. Therefore, any changes you make to 
the maps in this environment are for your eyes only. And because you are working on a copy of the maps, 
you will not inadvertently change the live library.

It also means that you can freely delete maps and sites from the library that you are uninterested in.

So, using the Library Explorer again, the Sandpit and Draft sites within Recruitment ToBe can be deleted, 
and so can the corresponding Map Stores. Within the 3 Master Map Store, all processes apart from those 
in the HR folder can also be deleted.
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Your Map Store therefore looks like:

That completes the first step towards quantifying the benefit of Process Improvement.

In part two of this four part series, I will take you through the second step.
This will be available on the Triaster website in February 2015:
www.triaster.co.uk/triaster-for-business-analysis.php 

Part three will be in the March/April 2015 Connector.

Simulation and Business Analysis – how do I learn more?

Are you are keen to see more about how Triaster’s Simulation capabilities are designed 
to provide fantastic new decision-making support for Business Analysts? Join the free 
Functionality CatchUp event on 25th February from 9.30am to 2.30pm at our offices  in 
Wallingford, when Michael Cousins’ session will take you through the highlights:

1. Automatic generation of end-to-end process costs

2. Breakdown of end-to-end process costs into each individual pathways and outcomes

3. How to easily compare several ‘to-be’ processes with the ‘as-is’

4. How to produce tables and visualisations to support a business case for change

In all of the above, ‘costs’ can be read as any set of metrics which is most meaningful to your business analysis activities  - 
cost, effort, time, resources etc.

Refreshments and lunch are provided and as usual there will be opportunities to network with other customers. 

 If you missed the
conference join us at our free 
Functionality CatchUp event 
on 25th February, for more 

information visit:
www.triaster.co.uk/functionalitycatchup 



Join the discussion at www.triaster.co.uk/connector

www.triaster.co.uk/connector www.triaster.co.uk/connector

Call us on +44 (0)870 402 1234
9

T.U.G. News
Linda Spinks presents the latest news from the User Group

Linda Spinks // User Group Chairperson

As a new year starts, I’m pleased to look
forward to some of the meetings planned
for 2015, at which we will discuss our
respective projects and feedback
comments and ideas to Triaster. 

Next Main User Group meeting 

The next main User Group meeting will be on 5th 
March and is being hosted by Lockheed Martin UK at 
Ampthill in Bedfordshire; because of the secure nature 
of this site we need to have a list of attendees available 
as soon as possible in order to enable the required 
security clearance. Please click here to register:
www.triaster.co.uk/connector-events-user-group.php 

Please note that this meeting will include the User 
Group AGM at which the constitution will be reviewed 
and User Group officers elected. The constitution 
requires that there must be at least ten members 
present to constitute a quorum and agree changes. 
Constitution changes and User Group officers must be 
proposed in advance, so please send any suggestions 
to user.group@triaster.co.uk

Engineering Group meeting

The Engineering Group meeting which was due to be 
hosted at Skanska (Maple Cross) on 27th January has 
unfortunately had to be postponed. Another date will 
be scheduled following the main User Group meeting 
in March. For those of you who aren’t aware, this group 
is open to any customers working with/within the 
Engineering industry. Therefore even if you are working 
for a Defence or Manufacturing company, you may find 
that areas of interest overlap. If you would like to be 
informed of the new date as soon as it becomes known 
please contact user.group@triaster.co.uk.

As a New Year reminder, the User Group Forum on 
LinkedIn is the ideal place for airing your thoughts and 
raising new ideas. 

WE TELL
YOU

Triaster customers and staff at last year’s conference.
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The forum can be both clicked to from the User Groups Secure page and via this link: 
http://tinyurl.com/pv5vnkp  If you aren’t already a member of this group, please simply request to join 
and the group owners will approve your request.

The User Group agenda includes workshop sessions where we discuss topics of particular
interest to the attendees. If you are attending (or thinking of attending) and have a burning
topic to discuss, please contact me via the e-mail address below so that we can pencil it
into the agenda.

And finally, Jo Dolton is sending e-mails to Triaster customers asking for your feedback on the 
Triaster User Group, I encourage you to respond to this short survey as we want to ensure that
the User Group community and meetings are as beneficial as possible to all Triaster customers.

user.group@triaster.co.uk

5 February: Enabling Change in the Public Sector
 

At Triaster’s Enabling Change event on 5th February 2015, we will showcase 
how we have been working with Public Sector organisations to help 
them support their approach to organisational development, culture 
transformation and process improvement. Speakers from Northamptonshire 
Police, Multi-Force Shared Services (MFSS) and NHS Gloucestershire will share 
their experiences of focussing on improvement initiatives and operational 
transformation while ensuring the delivery of effective and efficient services.

Hosted at Microsoft in London, this free event runs from 9am to 1pm 
(including lunch) and there will be time for networking before the event and 
at lunch after the presentations finish.

To sign up for the event and for further details, please go to www.triaster.co.uk/publicsector
or contact Victoria Glancy by e-mail info@triaster.co.uk

At the Health Foundation
we’re in quality improvement
for the long haul, but real success 
will be when Quality Improvement 
is business as usual for everyone in 
health care.
Jo Bibby, Director of Strategy,
The Health Foundation

Today I can announce a raft of reforms 
that we estimate could save over 2.5 
million police hours every year. That’s 
the equivalent of more than 1,200 
police officer posts. These reforms are 
a watershed moment in policing.
Theresa May

IMPORTANT
FORTHCOMING

EVENT!

YOU TELL
US
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A Glimpse of the Future
Andrew Ridgeley // Lead Software Engineer & Chris Mawdsley // Senior Software Engineer

A Glimpse of the Future was a technical track Conference session led by Andrew Ridgley and Chris 
Mawdsley. Below is their write up of what was demonstrated and discussed and how they have taken 
your input on board.

The theme of the 2014 Conference was the 3 ‘U’s (Useful, Usable and Useful). So, how did our ‘Glimpse of 
the Future’ session relate to this concept? Well, in a nutshell, the library is already Useful and our planned 
new features will make the library more Usable and more widely Used.

General Usability

A number of features to help usability were discussed. These were:

•	 Menu Editor: The initial version of this was released in May 2014 in version 14.1. Further 
enhancements are planned including automatically creating a menu structure from the maps’ folder 
structure. This functionality is planned to be released in late spring 2015.

•	 Breadcrumb Trial: This will show position in hierarchy, as well as displaying a history of pages visited to 
show the route taken to the current location.

•	 Hyperlink Integrity Checks: a checklist of links from the homepage, hyperlinks from maps and links 
across maps. 

•	 Mobile Interface: In version 14.1 a 
mobile version of the homepage was 
launched. A possible enhancement to 
this is the ability to add rolling news 
content.

Alerts and Approvals

Following the release of auto map synchronisation with version 14.3, work will begin on the development 
of further enhancements. The next step is to make the review of process maps much more automated. 
Although ‘review due’ e-mail alerts are issued in the current system, the process is still quite manual, with 
the need to edit Visio files to re-set the review date or request re-work on a process map. A web-based 
interface will be created allowing reviewers to either set a map as approved until next review date or 
notify the author that re-work is required to update the map.

The general consensus of our conference session attendees was that web-based (rather than Visio-based) 
systems are the way forward and so, in time, the approvals functionality is likely to become fully web-
based. This will allow features such as document approval, simultaneous approval status of multiple maps 
(including showing parent/child dependencies) and better visibility of the status of maps in the approvals 
process.

Triaster Software
Development
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Organisation Chart

One new concept demonstrated, was the Organisation Chart (Org Chart). Many of the organisations that 
Triaster deals with have complex HR structures; maintaining these manually in organisation charts can be 
a lengthy and time-consuming process. Triaster’s concept is to import data from Excel (which may have 
been generated from external data source, such as Oracle database, for example). This data would be 
then used to create an organisation chart (see below) in much the same way Excel can currently be used 
to create process diagrams. It would be possible to drill down to explore a hierarchy, for example, drilling 
down into a team to see its individual members. These Org Charts would then be published into a process 
library in the same way as process maps, allowing data (such as job titles or names) within the diagrams 
to be searched on in the same way as process maps.

New publication format

Triaster are aware of the need to make our solution fully cross-browser and mobile-friendly. We have been 
working on a proof of concept using a new publication format (using SVG files) and this was demoed at 
the conference and well received. 

This publication format will allow the properties pane to be replaced with a pop-up which will save screen 
space, be mobile-friendly and be more intuitive to use. It will also open the door for more customisation 
and configuration of the properties interface.
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The pan and zoom pane will be replaced with by 
Google maps style zoom control, or simply by the pinch 
and zoom capability of a mobile device screen.

In the long-term this will allow the Triaster solution to 
become more web-orientated and less reliant on Visio. 
We may see the editing of shape data being done on 
the web, with the advantage of instant updates to the 
process library. 

Personalisation

Over the time, another direction the product may take 
is ‘getting to know’ a particular user. For example, by 
keeping track of their favourites, listing their Top 10 
process maps or documents, showing targeted news 
or updates which are targeted to their area of the 
business, or even showing their task list. 

Have your say…

To input into discussions regarding Triaster software 
development please attend future User Group 
meetings and Customer Focus days. Dates and 
information about both can be found at:
www.triaster.co.uk/events

Naming Maps and their activities
and inputs or outputs 
Or how to stop using special characters!

Many Process Navigator users will know that solely alpha-
numeric characters should be used when titling process 
maps or their activities and deliverables. If you have 
attended Triaster’s Creating Maps Training, this will have 
been repeated a good number of times!

However a reminder may well be useful, as special 
characters must be avoided to ensure successful publishing 
of your maps to your Process Library. This includes full 
stops, commas, brackets, ampersands and colons.

Here are a couple of tips.

•	 If your activity has a full stop in it, this is likely to 
indicate that there are two activities which could 
be easily represented by two separate shapes. 
Remember, use the ‘how to’ test in front of the title. 
It works for map titles as well as activities. Keep your 
useful map usable and used by keeping descriptions 
to a minimum. If you need further detail, attach a 
document.

•	 Use the power of conjunctions! Commas and 
ampersands can be replaced by and, with or then. E.g.

Sign off the purchase order, confirm with line manager & 
release funds. 

Sign off the purchase order and provide confirmation to 
operations manager then release funds.

•	 Split your activities up to avoid overly long activity 
names and negate the need to use punctuation. Can 
you spot the obvious improvement opportunity above?

Triaster Suite version 14.3

Triaster Suite version 14.3 is being released in
early 2015.

To receive a Triaster Product Release and Technical 
Update e-mail informing you of this, please make 
sure you are signed up by completing a form found 
at: www.triaster.co.uk/contact.php

Triaster is of course able to deliver 
advice and consultancy services to 

create your process maps.

Please contact Customer
Services on 0870 402 1234 or 

customer.services@triaster.co.uk
for more information.
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Tech News
Using Notepad++ to edit and check XML files

John Blight // Technical Support Manager

We know that some struggle to maintain, for example, the ‘flash-menu.xml’ 
files that define the menus on a process library site’s homepage; even though 
XML is a text format, not everyone is comfortable editing it.

Notepad++ is a free text editor with extensive enhancements in comparison 
to Microsoft’s Notepad, included in Windows.
http://notepad-plus-plus.org/

Notepad++ can help by colour-coding an XML file’s content for easier 
readability, and with the numerous features of its XML Tools plugin.

Installing the XML Tools plugin

Using Plugin Manager
1. Run Notepad++.

2. Click ‘Plugins’ > ‘Plugin Manager’ > ‘Show Plugin Manager’ (Available plugins not already installed 
should be listed on the ‘Available’ tab).

3. Tick the ‘XML Tools’ check box, and click ‘Install’.

4. When prompted, choose to restart Notepad++.

5. If warned about the version of the plugin updater, just click OK.

6. Check that ‘XML Tools’ is available from the ‘Plugins’ menu.

Manual installation
If installing through Plugin Manager isn’t successful, manual installation is simple.

Download the files by clicking on the ‘XML Tools’ link here:
http://tinyurl.com/mheofew

The ZIP will contain these files:

ext_libs\
  iconv.dll
  libxml2.dll
  libxslt.dll
  zlib1.dll
XMLTools.dll

Notepad++
can be downloaded 

free from:

http://notepad-plus-plus.org
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These need to be copied to the Notepad++ installation.

C:\Program Files (x86)\Notepad++\
  plugins\
    XMLTools.dll
  iconv.dll
  libxml2.dll
  libxslt.dll
  zlib1.dll

Working on XML files in Notepad++

Colour-coding
When an XML file is open in Notepad++, if not already, apply colour coding:

‘Language’ > ‘XML’

       <?xml version=”1.0”?>
       <menu name=”links”>
              <menu name=”Level 1 - Sample 1”>

Checking syntax
Check the XML syntax:

‘Plugins’ > ‘XML Tools’ > ‘Check XML syntax now’

For example, a homepage that doesn’t display a menu suggests an error
in the XML of the site’s ‘flash-menu.xml’ file.

Applying ‘Pretty print’ layout
‘Pretty print’ will lay out the XML with indenting to reflect the XML structure, making it more readable and 
easier to understand.

‘Plugins’ > ‘XML Tools’ > ‘Pretty print (XML only – with line breaks)’

Note that this is a change to the file, adding extra whitespace, unlike the application of colour-coding, 
which is just a different way of presenting the content.

These are just some of the features of Notepad++ that can facilitate the maintenance 
of text files, such as XML files. There are so many more, which makes it a very popular 
utility here at Triaster, and indeed with many of our customers.

A version of this article is on our Knowledge Base.
http://knowledgebase.triaster.co.uk/help-for-library-administrators/notepadplusplus-xml-files

Related
Article

Upgrade to an HTML5
homepage. For more information
on the benefits of upgrading visit:

http://tinyurl.com/qe7hdfa
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Meet…Joel Evans

Since Joel joined the team as a Project Delivery 
Consultant, he has worked with a number of customers 
on various projects, but is currently focusing on process 
facilitation and process mapping with National Oilwell 
Varco (NOV) in Houston and Ohio. We asked Joel to 
share his experiences of working overseas with this 
multi-national company:

Visiting the USA/Canada five times since joining 
Triaster in June has provided me with some fantastic 
experiences so far. NOV are currently making great 
progress with their process improvement and it has 
been a pleasure to help them along the way. Each of 
my visits has differed greatly from the last, and splitting 
the time between Houston, Texas and Dayton, Ohio has 
given me some brilliant memories (and taught me a 
few things!).

My visit to Dayton in November was to work with a 
team of people from three different facilities, from three 
different parts of the world. Although these facilities 
all produce the same products, they were all going 
about it in different ways. Having previously mapped 
their current state processes in September, we spent 
a week putting all our energy into creating a future 
state process that they will all follow. And what have I 
learnt? Always check the weather for your destination 
before travelling, I was a little bit cold when I packed for 
summer in Ohio, and it was snowing when I arrived!

Joel would support the Team daily from 7am – 6.30pm 
answering any questions that were thrown his way and 
at the end of a hard day he would then request that he go 
back to his hotel and try to finish off the maps  -  we would 
have to drag him out to have dinner with us and the other 
members of the Team.
Mark Curtin, Program Manager – Business Process 
Management, National Oilwell Varco

Joined Triaster
June 2014

Before that
Implementation and Training Coordinator in 
Health and Safety Compliance

Professionally he is most proud of …
Maintaining great
business relationships

Hobbies
Music, sports
and history

Likes
People, animals,
food, shorts and
flip flops

Dislikes
Arrogance,
traffic and rum

Everyone at Triaster will always remember…
Joel’s fantastic French accent as ‘Pierre, The Chef 
Mariniere’ at the Triaster Conference Murder 
Mystery – it was so good it won a prize!

Project Delivery Consultant

Fact File

Joel ‘dragged out to 
dinner’ and a pub quiz 

with the NOV team...
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Community Events
Jo Dolton & Emily Wright review the upcoming calendar

Jo Dolton & Emily Wright // Customer Success Team

Triaster and our customers host a number of events as listed below. Many of these events are free of 
charge to organisations with a Trusted Partner Licence Agreement. Of course, all Triaster training courses 
can be delivered on-site, if you would like to discuss this further, please contact either of us by calling:
+44 (0) 870 402 1234 or e-mail customer.services@triaster.co.uk

Please do remember to register if you plan to join any of our webinars.

Date What is the 
Event?

Who benefits from 
attending?

How will I benefit? Location

19th & 20th Jan 2015
16th & 17th Mar 2015
11th & 12th May 2015
20th & 21st Jul 2015
14th & 15th Sep 2015
23rd & 24th Nov 2015

Triaster 2 Day 
Training - 
Creating Maps 
For Your Library 

Anyone needing 
to map their 
processes

This training course covers the basic software 
skills needed to create process maps with Process 
Navigator and publish them to your Library. 

“Just a short note to thank you and the team for 
the hospitality & quality of the training course I 
attended with a colleague earlier in the month. 
Everything was first rate, from the warm welcome 
on first arrival through to the end of the course, 
and we look forward to further on-going training 
in the future.” Spirax Sarco

Triaster HQ,
Oxfordshire

5th Feb 2015 Enabling Change 
in the Public 
Sector

Triaster 
customers and 
prospective 
users from the 
public sector 

Speakers from Northamptonshire Police, 
Multi-Force Shared Services (MFSS) and NHS 
Gloucestershire will share their experiences 
of focussing on improvement initiatives and 
operational transformation while ensuring the 
delivery of effective and efficient services.

Microsoft, 
London

25th Feb 2015 Functionality
CatchUp Event

Triaster 
customers who 
were unable to 
attend the 2014 
Conference

The purpose of this event is to provide you 
with an overview of current Triaster Solution 
functionality available, with particular focus on 
Triaster’s Simulation capabilities to quantify the 
benefit of Process Improvement.

Triaster HQ,
Oxfordshire

5th Mar 2015 Customer User 
Group

All Triaster 
customers

A great opportunity to meet customers from a 
variety of industries and share your views and 
experiences of Triaster. 

Lockheed 
Martin UK 
- Ampthill, 
Bedford

17th Mar 2015 Triaster Training 
- Technical 
Workshop 

Library 
Administrators, 
IT and Support 
professionals

The workshop answers in-depth all of the 
commonly asked technical questions about the 
Triaster Server installation, as well as providing 
plenty of opportunity for delegates to discuss 
their own systems.

Triaster HQ, 
Oxfordshire

mailto:customer.services@triaster.co.uk
http://triaster.co.uk/connector_events_public_training.php
http://triaster.co.uk/connector_events_technical_workshops.php
http://triaster.co.uk/connector_events_user_group.php
http://www.triaster.co.uk/connector-events-enabling-change.php
http://www.triaster.co.uk/functionalitycatchup
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Date What is the 
Event?

Who benefits from 
attending?

How will I benefit? Location

Late April - TBC Triaster 
Breakfast 
Seminar : How 
Do I..?

All Triaster 
customers and 
prospective 
users in 
the Triaster 
community

This interactive round table workshop steers 
you to make the most of your Process Library. 
What should be in your Library? How do you 
ensure your content gets used? Making processes 
personal really does work, and this seminar 
focuses on real customer experience.  If you fix 
problems for people, then your system is going to 
be used.

TBC

TBC 2015 Triaster 
Customer Focus 
Day

All Triaster 
customers

Customer Focus Days give the opportunity to 
workshop with Triaster development regarding 
both software and services and directly influence 
and impact the end results.

“A golden opportunity to influence the 
development of the solution to deliver your 
company objectives.” - Skanska “

Triaster HQ, 
Oxfordshire

Date TBC Engineering 
Special Interest 
Group Meeting 

Triaster 
customers in 
the Engineering 
sector

Meeting users in the Engineering sector who 
are able to share, understand and solve each 
other’s problems with process in this particular 
environment.

Skanska UK, 
Rickmans-
worth

Date TBC Release Update 
Webinars

All Triaster 
customers

An executive briefing from the Triaster Team 
looking at new features from Triaster, what’s 
happening in the Triaster Community and what’s 
coming up next.

Webinar

Dates available on 
application

Triaster Training 
- Process 
Discovery 
Facilitation 

Anyone 
responsible 
for process 
discovery 

Training that covers the skills and approaches 
that will enable you to successfully facilitate your 
process discovery workshops. (Triaster can also 
deliver on-site process discovery workshops.)

Triaster HQ, 
Oxfordshire

For more information and registration for 
Community Events please go to:
www.triaster.co.uk/events.php 

Also, please be aware that you can sign 
up to receive e-mail updates on events by 

completing an enquiry form here:
www.triaster.co.uk/contact.php 

http://triaster.co.uk/connector_events_process_discovery.php
mailto:customer.services@triaster.co.uk
http://triaster.co.uk/connector_events_public_focus_day.php
http://triaster.co.uk/connector_events_special_interests.php
mailto:info%40triaster.co.uk?subject=Please%20send%20me%20information%20about%20the%20Breakfast%20Seminar%20%3A%20How%20Do%20I..?
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From the Community
Latest news and discussion

Hidden talents

Lewis Gabb,
Project Improvement 

Officer, Programme ASPIRE, 
Northamptonshire Police 

creates amazing leatherwork, 
often used in films.

Snapshots: Nov & Dec @ Triaster!

Answers to the November/
December puzzles
So were you paying attention?

SCAMPERING POPS
PROCESS MAPPING

REST FIERCER NEON CAT
TRIASTER CONFERENCE

MOVEMENT RIP
IMPROVEMENT

REM TASTES RICH
CHRISTMAS TREE

DINER ERE
REINDEER

ADVANCED ANTLER
ADVENT CALENDAR

ACROSS

3   WRIGHT

5   NORTHAMPTONSHIRE

7   DEXTER

8   STEVE

9   BRISTOL

10 BRACELETS

DOWN

1   HOBBITON

2   BRAHAM

4   WOODLAND

6   RESPONSIBILITY

Do you have a
hidden talent? Share it 

with us in the Connector. 
Send your photos to 

customer.services@triaster.co.uk

There was a ‘moustache-off’ as some of the 
Triaster team took part in Movember...

...but the hands-down 
winner was John Blight’s 

little cousin Florence!

December 
saw blizzard 
conditions 
in the office, 
a visit from 
secret Santa...

Must try 
harder next 

year Victoria.

...and a particularly 
worrying outbreak 
of ‘Christmas 
knitwear’.
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3 ‘U’s Checklist
As promised at the Conference

Michael Cousins // Managing Director

The 2014 Triaster Conference 
was a real joy to be a part of. 
There were so many excellent 
presentations and opportunities 
to learn and share from peers.

Throughout the conference, the underlying 3 ‘U’s theme 
kept surfacing. In each session, the speakers related 
their thoughts and ideas to the key principle of the 3 
‘U’s. This is: ROI from a Process Library comes from its 
Use, and this will only happen if it is Useful and Usable.

I promised a checklist at the conference close; to help 
Triaster customers understand where their own projects 
are at with reference to the 3 ‘U’s. Well, I have decided 
to go one better and to implement the checklist as 
a survey. You can still use it as a checklist though by 
simply printing out the questions.

Draft 1 of the survey is here:
https://www.surveymonkey.com/s/triaster3us

This survey takes just a few minutes to complete, and 
we’d be very happy to work with any of our customers 
that might like to use this survey with their own 
organisations. Please email me personally if you would 
like to do this (michael.cousins@triaster.co.uk).

If you’d like to complete the survey from your own 
perspective for your own organisation, Triaster will 
receive the results and our intention is to anonymise 
them but publish an average score as a way of allowing 
benchmarking between customers. Should there be a 
reasonable number of survey completions we will share 
the average in a future edition of the Connector.

The absolute scores do not matter so much, what 
matters more is their trend over time. So, if you do 
decide to survey your staff, consider repeating the 
survey a year later and see if the scores have shifted in 
one direction or the other. This will clue you in quite 
quickly to any positive or negative changes in the 3 ‘U’s.

Mike introduces the 3’U’s theme at last year’s conference.


